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Overview


[image: _images/overview.png]

Fig. 1 Xena2889 overview



This is the user manual for Xena2889. Xena2889 is a Windows application that enables you to perform advanced network tests according to the RFC 2889[#1] using one or more of the Xena test equipment chassis.

The Xena2889 application features the following capabilities:


	Enables the user to create, edit and execute test configurations using Xena Networks test equipment in accordance with RFC 2889[#2].


	Ability to individually configure and enable the test-types defined in RFC 2889[#3].


	Support for multiple ValkyrieBay and ValkyrieCompact test chassis.


	Support or different network topologies and traffic flow directions.


	Support for both layer 2 and layer 3 testing.


	Support for IPv4 and IPv6.


	Support for multiple ValkyrieBay and ValkyrieCompact test chassis.


	Ability to flexibly define the protocol layers supported by the test (Ethernet, VLANs, IP, UDP, etc.).


	Ability to assign separate protocol layer definitions to each test port.


	Test reports can be created in either PDF or XML format or both.


	Extensive configuration options to fine-tune the tests.





Footnotes



[#1]
https://datatracker.ietf.org/doc/html/rfc2889.html



[#2]
https://datatracker.ietf.org/doc/html/rfc2889.html



[#3]
https://datatracker.ietf.org/doc/html/rfc2889.html





            

          

      

      

    

  

    
      
          
            
  
Installation

Xena2544 is a Windows desktop application compatible with Windows 8 and later versions.

It comes pre-installed as an integral component of the standard Xena software release package, which is available for download from this source[#1].

Following the installation, you can locate a shortcut to the application in the Start ‣ Programs ‣ Xena Network menu, and additionally (if you opted for this during the setup process), on your desktop.


[image: ../_images/installation.png]


Footnotes



[#1]
https://xenanetworks.com/l23-downloadsw/





            

          

      

      

    

  

    
      
          
            
  
Available Tests

The following RFC 2889[#1] tests are fully supported by the Xena2889:


Throughput and Forwarding Rate Tests

To determine the throughput, frame loss and forwarding rates of DUT/SUTs for 3 configurations:


[image: ../_images/rate_tests.png]

Fig. 2 Rate Test Topology




	Throughput: Highest data rate that can pass through the DUT/SUT without frame loss


	Forwarding Rate: Highest data rate that can pass through the DUT/SUT - frame loss may be experienced


	Flood count: Any frame originating from the DUT/SUT MUST not be counted as a received frame.  Frames originating from the DUT/SUT MAY be counted as flooded frames or not counted at all.






Congestion Control

To determine how a DUT handles congestion.  Does the device implement congestion control and does congestion on one port affect an uncongested port.


[image: ../_images/congestion_control_test.png]

Fig. 3 Congestion Control Test Setup





Forward Pressure

The Forward Pressure test overloads a DUT/SUT port and measures the output for forward pressure.


[image: ../_images/forward_pressure.png]

Fig. 4 Forward Pressure Test Setup





Maximum Forwarding Rate

Measure the peak value of the Forwarding Rate when the Offered Load is varied between the throughput and the Maximum Offered Load.


[image: ../_images/max_forward.png]

Fig. 5 Maximum Forwarding Rate Test Setup





Address Caching Capacity

To determine the address caching capacity of a LAN switching device.


[image: ../_images/addr_cc.png]

Fig. 6 Address Caching Capacity Test Setup



Procedure:


	Send traffic with a range of MAC addresses as source addresses from tester to learning port - DUT caches as many MAC addresses as possible


	Send traffic with same range of MAC addresses as destination MAC addresses from tester to test port


	Traffic with non-cached MAC addresses are broadcasted and reach the Monitoring port


	If all MAC addresses are cached, no traffic will reach Monitoring port


	Test repeats until no traffic is detected on Monitoring port






Address Learning Rate

To determine the rate of address learning of a LAN switching device.


[image: ../_images/addr_lr.png]

Fig. 7 Address Learning Rate Test Setup



Procedure:


	Send traffic with a range of MAC addresses as source addresses from tester to learning port - DUT caches as many MAC addresses as possible


	Send traffic with same range of MAC addresses as destination MAC addresses from tester to test port


	Traffic with non-cached MAC addresses are broadcasted and reach the Monitoring port


	If all MAC addresses are cached, no traffic will reach Monitoring port


	Test repeats until no traffic is detected on Monitoring port






Errored Frames Filtering


Important

Supported with the exception of the Dribble Bit Errors and Alignment Errors tests.



Determine the behavior of the DUT under error or abnormal frame conditions. The results of the test indicate if the DUT/SUT filters the errors or simply propagates the errored frames along to the destination.


[image: ../_images/errored_frame.png]

Fig. 8 Errored Frames Filtering Test Setup





Broadcast Forwarding

Determine the throughput and latency of the DUT when forwarding    broadcast traffic. The ability to forward broadcast frames will depend upon a specific function built into the device for that purpose.  It is therefore necessary to determine the ability of DUT/SUT to handle broadcast frames, since there may be many different    ways of implementing such a function.


[image: ../_images/broadcast_forward.png]

Fig. 9 Broadcast Forwarding Test Setup





Footnotes



[#1]
https://datatracker.ietf.org/doc/html/rfc2889.html





            

          

      

      

    

  

    
      
          
            
  
Getting Started

This section will help you getting started using the Xena2889 by showing a few simple examples on how to create and to execute various tests.



	Performing Rate Test (Plain Ethernet)

	Performing Rate Test (IPv4)

	Performing Errored Frames Filtering Test

	Step-By-Step Guide
	Add Chassis

	Add/Configure Port/s

	Protocol Segment Profiles

	General Test Configuration

	Test Types configuration

	Reporting

	Save and Start










Footnotes



            

          

      

      

    

  

    
      
          
            
  
Performing Rate Test (Plain Ethernet)

This example explains how to create and execute a simple rate test using two test ports.

A “rate test” is a test that focus on the throughput and forwarding aspects of the DUT. All the tests defined in RFC 2889 #section5.1[#1] to RFC 2889 #section5.4[#2] are considered to be rate tests. These tests mainly differ in terms of the used network topology and traffic direction but the basic test methodology is the same for all rate tests.

In this example we will use a Full Mesh topology with three test ports, using plain Ethernet traffic.


[image: ../_images/rate_test_eth.png]

Fig. 10 Performing Rate Test (Plain Ethernet)



Perform the following steps to create and execute this test:


	Start the Xena2889 application.


	Click the Add Chassis button in the toolbar and enter the IP address and password of the Xena tester you want to use. Keep the default value of 22606 for the port number unless you know that your tester is configured with a different port number. Press OK. The Xena2889 will now connect to the chassis and display all available modules and ports in the Physical Ports panel to the left.


	Locate three test ports that you want to use in the Physical Ports panel and ensure that they are connected to your DUT. Select each port in the tree view, right-click and select the Add Port to Test Configuration menu option in the popup menu. You can select multiple ports by holding down the Ctrl or the :kdb`Shift` button while clicking with the mouse.


	Change to the Selected Ports panel. You should now see the three ports you selected previously. Leave each port configuration at its default value.


	Change to the General Test Configuration panel. If you know that your DUT has a throughput that is lower than the physical port speed by several orders of magnitude you can lower the used test port rate in the Overall Test Port Rate section at the top-right. Otherwise you may leave the general settings at the default values.


	Change to the Test Types Configuration panel. You will now see a tree view to the left containing all defined tests. All tests are enabled by default so you should start with clicking the Disable All Tests button at the bottom of the tree view (this is the button with an empty square image). You can also disable all tests by clicking the checkbox to the left of each test.


	Re-enable the Full Mesh rate test at the top and select the entry in the tree view. This is display the test options for this test in the configuration panel to the right. Note the list at the bottom of the configuration panel which show all the selected ports.


	Press the Select All Ports button at the bottom of the configuration panel. This will include all the selected ports in the current rate test . Leave all other configuration options at their default values.


	Select the File ‣ Save … menu item or press Ctrl+S in order to save your configuration. Give the configuration a suitable filename.


	Press the Start button in the top toolbar or press Ctrl+T. The test will now start.


	The Result Data panel at the bottom will display both progress information while the test is ongoing and also the final test results. Progress data will be shown with an italics font whereas final test results will be shown with a normal font.


	Once the test completes a PDF report will be generated and shown using your default PDF viewer application.




The overall result will contain one result for the throughput test and one result for the forwarding test.


Footnotes



[#1]
https://datatracker.ietf.org/doc/html/rfc2889.html#section5.1



[#2]
https://datatracker.ietf.org/doc/html/rfc2889.html#section5.4





            

          

      

      

    

  

    
      
          
            
  
Performing Rate Test (IPv4)

This example will show how to expand the above rate test using IPv4 test traffic. It expands on the previous example so we will only describe the main differences in detail. For the sake of variety we will use a Pairs topology instead of the Full Mesh topology used in the previous example.


[image: ../_images/rate_test_ip.png]

Fig. 11 Performing Rate Test (IPv4)




	Start the application, and connect to a chassis as before.


	Select two test ports that are connected to a DUT that support IPv4 traffic and add them to the Selected Ports panel.


	Change to the Selected Ports panel. For each port set the Protocol Segment Profile option to the Ethernet / IPv4 profile.


	Select the IP Address cell for the first port. Enter the IP address you want to assign to this port. Note that the Gateway Address cell is automatically initialized using an educated guess for what the gateway address might be. Change the Prefix and/or the Gateway Address cells as needed.


	Configure the IP address options for the other port in a similar way.


	Change the General Test Configuration options as needed.


	Change to the Test Types Configuration panel, and disable all existing tests.


	Add a new rate test by clicking on the Add button located at the bottom of the test tree view to the left.The new test will be enabled by default.


	Set the topology to Pairs and the direction to Bidirectional.


	Set both ports to be used. Set the first port role to East and the other port role to West. Pair the two ports together using the Port Peer column.


	Save the configuration and start the test.




The overall result will contain one result for the throughput test and one result for the forwarding test.


Footnotes



            

          

      

      

    

  

    
      
          
            
  
Performing Errored Frames Filtering Test

This example will show how to configure and run one of the other test types.


[image: ../_images/errored_frame_test.png]

Fig. 12 Performing Errored Frames Filtering Test




	Start the application, and connect to a chassis as before.


	Select two test ports that are connected to a DUT and add them to the Selected Ports panel.


	Change to the Test Types Configuration panel, and disable all existing tests, except the Errored Frames Filtering test.


	Select both ports to be used in the test. Set one port as the Source and the other as the Destination.


	Save the configuration and start the test.




The result will show the amount of frames transmitted and received in the various frame groups.


Footnotes



            

          

      

      

    

  

    
      
          
            
  
Step-By-Step Guide


Add Chassis


[image: ../_images/step_by_step_1.png]

Click the Add Chassis button.


[image: ../_images/step_by_step_2.png]

Enter the IP of the Management port under Chassis Address. Use xena as default Chassis Password.



Add/Configure Port/s


[image: ../_images/step_by_step_3.png]

Select the Port(s) you need to use.


[image: ../_images/step_by_step_4.png]


	Set port addresses


	Configure Physical Port Properties


	Choose rate cap


	Configure peer negotiation (depending on the module you use, some properties are not applicable.)





See also

Check Selected Ports Panel for details.





Protocol Segment Profiles


[image: ../_images/step_by_step_5.png]


	Add new profile.


	Select the new profile.


	Add additional headers.


	Choose Segment.





See also

Check Protocol Segment Profile Panel for details.





General Test Configuration


[image: ../_images/step_by_step_6.png]


	Set frame size






Test Types configuration


[image: ../_images/step_by_step_7.png]


	Select the test you want to run


	Assign the proper port roles for each test





See also

Check Test Types Configuration Panel for details.





Reporting


[image: ../_images/step_by_step_8.png]

Select the report format you want to generate.


See also

Check Report Options Panel for details.





Save and Start

Start the test. Xena2889 will automatically reserver the ports and ask you to save the test configuration.



Footnotes



            

          

      

      

    

  

    
      
          
            
  
General Panels

The main Xena2889 application screen is shown in the image below.


[image: ../_images/general.png]

Fig. 13 Xena2889 application screen




	At the top you find a menu bar with accesses various application-level functions. You also find a toolbar with quick shortcuts to the most used functions.


	At the left you find a tree view named “Physical Ports” showing the available Xena chassis, modules and ports.


	At the right you find a tabbed view with various application panels. These are explained below.


	At the bottom you also find a tabbed view containing a few status panels. These are also explained below.





Application Panels


	Start Page

The default main page shown to the user. This page contains a brief guide to assist you in creating an initial test configuration. You can close this panel once you feel that it is no longer useful to you.



	Selected Ports

This panel allows you to include Xena test ports in your test and to configure the behavior of these ports. You select the ports in the Physical Ports view and drag them to theSelected Ports panel to include them in the test.



	General Test Configuration

This panel control the common aspects of the Test Configuration, such as frame sizes and port rates.



	Test Types Configuration

This panel control what tests you are actually going to execute and also handles the test type-specific configuration options.



	Protocol Segment Profiles

This panel allow you to create and/or configure profiles for protocol segment headers. Each port can be assigned a different protocol header so that it is possible to give each port a different set of headers.



	Reporting Options

This panel control all aspects of the reporting function.







Status Panel


	Result Data

This panel displays the test result data in a grid view. Both the progress counters and the final test data is shown. Progress counters are shown using an italics font whereas the final data is shown with a normal font.



	Configuration Errors

This panel displays any configuration errors detected in your configuration when attempting to start a test.







Footnotes



            

          

      

      

    

  

    
      
          
            
  
Physical Ports Panel

This panel displays all available ports on the currently connected Xena chassis. It is possible to connect to multiple Xena chassis at the same time.


[image: ../_images/phy_ports_panel.png]

Fig. 14 Physical Ports Pane



It also allows you to perform the following actions:


	View the current sync (link) and traffic state of the ports.


	View the ownership of the ports, i.e. are the ports reserved and by whom.


	Request or relinquish ownership of ports.


	Determine which ports will be used in the multicast tests.




You can reserve or relinquish ownership of a port by right-clicking on it and selecting the appropriate action.


Note

Note that the Xena2889 will automatically reserve ownership of used ports when a test is started.




Footnotes



            

          

      

      

    

  

    
      
          
            
  
Selected Ports Panel

This panel displays the ports that have been actively selected for use in the test configuration.


	Port Name

The name (ID and type) of the port.



	Port Speed

The physical port speed to use in the test. Normally this should be left at the default AUTO value, but certain DUTs require that the port speed is fixed to a specific rate.



	IP Address

The IP address that you want to use for the port. All ports in the configuration need an IP address.



	Prefix

The decimal network prefix for the address.



	Gateway Address

The gateway address for the assigned IP address. Usually this will be the address of the DUT port which the test port is connected to.



	Protocol Segment Profile

The protocol segment profile to use for this port. Profiles can be created, edited and deleted in the separate Protocol Segment Profiles panel.





Below the grid view is a section with less-frequently-used settings:


	Inter-Frame Gap

Specifies the minimum gap between frames generated for a port, expressed as a number of bytes.



	Speed Reduction

Specifies an optional speed reduction on the transmit side of the port, expressed as a ppm value.



	Enable PAUSE Mode

Controls whether the port responds to incoming PAUSE frames.



	Enable Auto Negotiation

Controls whether auto-negotiation for the port is enabled or not.



	MDI/MDIX Mode

Controls MDI/MDIX Mode



	BBR Mode

Control BroadR-Reach mode





It is possible to change settings on multiple ports at the same time by selecting multiple ports in the grid view and then changing settings in either the grid view or the detailed settings panel below the grid. The only setting that does not allow this is the IP address field, as this must always be a unique value.


Footnotes



            

          

      

      

    

  

    
      
          
            
  
General Test Configuration Panel

This panel controls the test options that are common for all tests. The various sections in the panel are described below.


[image: ../_images/general_test_config_panel.png]

Fig. 15 General Test Configuration Panel




Frame Sizes

This section allows you to specify the frame sizes to be used by the various tests. The available frame size options are divided into two groups, the Fixed Sizes Per Trial and the Varying Sizes Per Trial.

As the name indicates the Fixed Sizes Per Trial group uses a single frame size per trial. It is possible to specify multiple frame sizes which will cause the test to be repeated for each frame size. The Varying Sizes Per Trial group will use many frame sizes for each trial. This is controlled by the hardware.


Note

Note that when calculating bit rates the average frame size will be used.




Note

Also note that the Errored Frames Filtering test will not used the frame size setting as it uses its own frame size setup as part of the test.





Overall Test Port Rate

This section allow you to specify the overall rate used by the tests. You can specify the rate using one of the following methods:


	A fraction (percentage) of the physical port speed


	A frame-rate (Fps) value


	A bit-rate (Bps) value at either layer 1 or layer 2.




Below the controls you can see the resulting percentages or rates for all selected port types.


Note

Note that the Address Caching Capacity and Address Learning Rate tests do not use the overall test port rate as they utilize their own rate definition. The Congestion Control and Forward Pressure tests also do not use the overall test port rate as these tests are always performed at port line speed.





Misc. Options


	Use Micro-TPLD if needed

The normal Xena test payload (TPLD) section takes up 20 bytes and is used for various purposes, such as latency measurements, loss and misordering monitoring, payload integrity, etc. Due to this test payload it may be impossible to make room for protocol headers such as IPv4+UDP for smaller frame sizes (e.g. ~64 byte).

By enabling this option you permit Xena2889 to use the smaller micro-TPLD if needed by the current frame size. The consequence of this will be that realtime monitoring of packet loss is no longer possible.

Note that Xena2889 will only use the micro-TPLD for a test run if the current frame size requires it. If you for instance use the default IEEE packet size distribution you may encounter that the micro-TPLD is only used for 64 byte packets but not for the other packet sizes.



	TID Alloc.Scope

Determines how Xena2889 allocates test payload identifier (TID) values.


	Configuration Scope: Allocates a unique TID value for each stream created. This option ensures that only packets intended for a given port is taken into account. The downside is that for large configurations you may quickly run out of TID values due to hardware constraints.


	Rx Port Scope: Allocate TIDs so that all streams received on any given port have a unique TID. TID values are reused between ports. This allow for larger configurations but the test is no longer able to detect if packets are mis-delivered by the DUT.


	Source Port ID: Allocate TIDs so that all streams from a given port is set equal to the port index in the configuration. This is a slight variation of the previous method.






	Latency Mode

Specifies the way the latency value is calculated. Refer to the description of P_LATENCYMODE in the CLI document[#1] for a description of the various values.



	Toggle Sync State

If checked the sync state for all selected ports will be toggled off and on at the start of each test trial. This is done to ensure that the DUTs MAC-tables are cleared at the start of each test.

Note that the Address Caching Capacity and Address Learning Rate tests do not use this option as they use their own definition.



	Sync State Off Period

The number of seconds to keep the port sync state off.



	Delay After Sync On

Defines how long time Xena2889 will wait after the reset before it continues with the test.







Port Scheduling

If the Use Port Sync. Start option is checked the Start button will activate a synchronized port start mechanism for the ports - if the chassis firmware version supports this feature.

The Port Stagger Steps property delays start of traffic generation on one port relative to pressing Start button. The delay is programmed in steps of 64 microseconds. The Port Stagger function works between ports on test modules installed in the same chassis.


	The 1st port will not be delayed.


	The 2nd port will be delayed with the Port Stagger Steps.


	The 3rd port will be delayed with the Port Stagger Steps * 2.


	The 4th port will be delayed with the Port Stagger Steps * 3 etc.




The maximum value of Port Stagger Steps for a port is 31250. Therefore the programmed Port Stagger Steps must not exceed 31250/(number of ports).


Note

This requires that Use Port Sync. Start has been checked.



The Resulting Delta is Port Stagger Steps * 64 microseconds


Important

Please observe that on Z800 module (Freya), you will need to uncheck the Use Port Sync. Start box to get Xena2889 to complete.





Reset and Error Handling

If Stop on LOS is enabled, Xena2544 will abort the test if a port loses the sync state during test.

When a Xena2544 test is started, the selected ports will be reset to ensure a known starting point for the test. The Delay After Reset parameter defines how long time Xena2544 will wait after the reset before it continues with the test.

If Port Reset is enabled, Xena2544 will reset the test ports when starting the test.



Footnotes



[#1]
https://docs.xenanetworks.com/projects/xoa-cli/en/latest/cli_ref/port/tg/latency/p_latencymode.html#p-latencymode





            

          

      

      

    

  

    
      
          
            
  
Test Types Configuration Panel

This panel allow you to select which tests are executed and configure their parameters.


[image: ../_images/test_types_1.png]

Fig. 16 Test Types Configuration Panel




Selecting Tests for Execution

All available tests are shown in the tree view to the left. You can select if a test is executed by using the checkbox to the left of the test name. You can also use the two small buttons in the toolbar at the lower part of the tree view to quickly enable or disable all tests.



Configuring Test Options

To inspect and optionally change the test options for a test, select the test in the tree view. The associated test options will then be displayed in the configuration panel to the right.

Each test contains a port role configuration control at the bottom of the associated configuration panel. This control enables you to select which of the selected ports should actually be used in the test and also to configure the role that each port should play in the test.



	Rate Tests Options
	Common Options

	Traffic Setup

	Throughput Test Options

	Forwarding Test Options

	Port Role Configuration





	Congestion Control Test Options
	Common Options

	Port Role Configuration





	Forward Pressure Test Options
	Common Options

	Test Options

	Port Role Configuration





	Maximum Forwarding Rate Test Options
	Common Options

	Rate Sweep Options

	Port Role Configuration





	Address Caching Capacity Test Options
	Common Options

	MAC Address Settings

	Learning Rate Settings

	DUT Address Learning Reset

	Misc. Options

	Port Role Configuration





	Address Learning Rate Test Options
	Common Options

	MAC Address Settings

	Learning Rate Settings

	DUT Address Learning Reset

	Port Role Configuration





	Errored Frames Filtering Test Options
	Common Options

	Rate Sweep Options

	Test Frame Options

	Port Role Configuration





	Broadcast Forwarding Test Options
	Common Options

	Throughput Test Options

	Port Role Configuration











Footnotes



            

          

      

      

    

  

    
      
          
            
  
Rate Tests Options


[image: ../_images/rate_tests_config.png]

Fig. 17 Rate Tests Options



RFC 2889[#1] defines several types of rate tests, but these are typically not possible to execute using the same test setup as the required cabling and equipment will typically differ quite substantially. Instead the Xena2889 allow you to create and define the number of rate tests relevant for the actual DUT.

Each rate test consist of two possible subtests:


	The Throughput test, which attempts to measure the maximum zero-loss rate for the DUT. This test is an iterative test and will provide exactly one test result.


	The Forwarding test, which performs a rate sweep and measures the loss at each rate. This test provides one test result for each tested rate in the rate sweep.




You can enable either both these subtests or just one of them.

To create a new rate test press the Add button located at the bottom of the test tree view. You can configure both the topology and the direction for the rate test, and also set the port roles for the test.

To delete a rate test select the test and press the Remove button located at the bottom of the test tree view.


Common Options


	Test Label

A text label for this rate test. Use this to assign a short description of the purpose of the test.



	Duration

The duration of each test trial in seconds.



	Iterations

The number of times to repeat each test trial with the same set of test parameters.







Traffic Setup


	Topology

The topology of the test traffic:


	Mesh




All test ports send traffic to all other test ports. The Direction option is ignored as Mesh traffic is always bidirectional.
* Blocks

Each test port is placed in either the East or the West block. Every port in the transmitting block sends traffic to every port in the other block. The Direction option determines if only one block or both will be transmitting.
* Pairs

Each test port is placed in either the East or the West block. Then the ports are paired together two and two. Traffic is only flowing between paired ports. The Direction option determines which ports will be transmitting.



	Direction

Determines the direction of the test traffic.







Throughput Test Options


	Enable Throughput Test

If checked the Throughput test will be executed. This is an iterative test that will find the largest throughput rate with zero loss for the DUT.



	Initial Rate

The starting rate to use. This is specified as a percentage of the overall port rate defined in the general test options panel.



	Maximum Rate

The maximum rate to use. This is specified as a percentage of the overall port rate.



	Minimum Rate

The minimum rate to use. This is specified as a percentage of the overall port rate. If the iteration reaches this value the test is stopped and the result will be FAILed.



	Resolution Rate

The trial stops when the difference between the current and the last successful trial is less than the Resolution.







Forwarding Test Options


	Enable Forwarding Test

If checked the Forwarding test will be executed. This is a rate sweep test that will measure the forwarding rate and the loss for the DUT at various transmit rates.



	Start Rate

The starting rate percentage used in the test.



	End Rate

The ending rate percentage used in the test.



	Step Rate

The rate step increment.







Port Role Configuration


	Used?

If checked the port will be used in this test.



	Port Role

Used to place the port in either the East or the West block. Only available when Topology is either Blocks and Pairs



	Port Peer

Used to pair the port with another port. Only available when Topology is Pairs.







Footnotes



[#1]
https://datatracker.ietf.org/doc/html/rfc2889.html





            

          

      

      

    

  

    
      
          
            
  
Congestion Control Test Options


[image: ../_images/congestion_control_test_config.png]

Fig. 18 Congestion Control Test Options




Common Options


	Duration

The duration of each test trial in seconds.



	Iterations

The number of times to repeat each test trial with the same set of test parameters.







Port Role Configuration


	Used?

If checked the port will be used in this test.



	Port Role

Used to place the port in either Source or Destination.







Footnotes



            

          

      

      

    

  

    
      
          
            
  
Forward Pressure Test Options


[image: ../_images/forward_pressure_config.png]

Fig. 19 Forward Pressure Test Options




Common Options


	Duration

The duration of each test trial in seconds.



	Iterations

The number of times to repeat each test trial with the same set of test parameters.







Test Options


	Interframe Gap Delta

The difference between the default inter-frame Gap (IFG) value of 20 bytes and the reduced value used on the source port.



	Accept. Rx Util. Delta

The acceptable receive rate utilization delta, i.e. the value with which the receive rate is allowed to exceed 100.0%.







Port Role Configuration


	Used?

If checked the port will be used in this test.



	Port Role

Used to place the port in either Source or Destination.






Note

Only one source and one destination are allowed in this test.
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Maximum Forwarding Rate Test Options
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Fig. 20 Maximum Forwarding Rate Test Options




Common Options


	Duration

The duration of each test trial in seconds.



	Iterations

The number of times to repeat each test trial with the same set of test parameters.







Rate Sweep Options


	Start Rate

The starting rate percentage used in the test.



	End Rate

The ending rate percentage used in the test.



	Step Rate

The rate step increment.



	Throughput as Start

Use a previously measured throughput value as a start rate if available for the current frame size.







Port Role Configuration


	Used?

If checked the port will be used in this test.



	Port Role

Used to place the port in either Source or Destination.






Note

Only one source and one destination are allowed in this test.
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Address Caching Capacity Test Options
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Fig. 21 Address Caching Capacity Test Options




Common Options


	Iterations

The number of times to repeat each test trial with the same set of test parameters.







MAC Address Settings


	Test Port Address Mode

Defines how to generate the test port MAC address.



	Learn Port DMAC Mode

Defines how to generate DMAC address in frames from the learning port.



	Learning Sequence

Select how the MAC address learning sequence is scheduled.



	Learning Base Address

The first 3 bytes of the MAC addresses used for the learning test. It is necessary to use a different base address than the default Xena base address (04.F4.BC) when running a test using multiple addresses to avoid conflicts with other unused ports on the Xena tester.



	Initial Count

The starting address count to use.



	Maximum Count

The maximum address count to use.



	Minimum Count

The minimum address count to use. If the trial reaches this value the test is stopped and the result will be FAILed.



	Resolution Count

The trial stops when the difference between the current and the last successful trial is less than the Resolution.







Learning Rate Settings


	Learning Rate

The learning rate in frames/second to use.







DUT Address Learning Reset


	Toggle Sync States

If checked the sync state of the test ports will be toggled off and on between test trials. Enabling this may help clearing the MAC learning tables in the DUT and speed up the test.



	Sync State Off Period

The amount of seconds the port sync states will be off.



	Delay After Sync On

Defines how long time Xena2889 will wait after the reset before it continues with the test.



	Switch Test Port Roles

If checked the port with the Test and Learning roles will be swapped between test trials. Enabling this may help clearing the MAC learning tables in the DUT and speed up the test.



	DUT Aging Time

If none of the two options above are checked the test will wait for the specified seconds between trials to ensure that the MAC table in the DUT has been cleared.







Misc. Options


	Fast Run Resolution

Enable this option to perform fast resolution of a test run based on polled data.







Port Role Configuration


	Used?

If checked the port will be used in this test.



	Port Role

Used to place the port in Test Port, Learning Port, or Monitoring Port.






Note

Only one test port, one learning port and one monitoring port are allowed in this test.
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Address Learning Rate Test Options
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Fig. 22 Address Learning Rate Test Options




Common Options


	Iterations

The number of times to repeat each test trial with the same set of test parameters.







MAC Address Settings


	Test Port Address Mode

Defines how to generate the test port MAC address.



	Learn Port DMAC Mode

Defines how to generate DMAC address in frames from the learning port.



	Learning Sequence

Select how the MAC address learning sequence is scheduled.



	Learning Base Address

The first 3 bytes of the MAC addresses used for the learning test. It is necessary to use a different base address than the default Xena base address (04.F4.BC) when running a test using multiple addresses to avoid conflicts with other unused ports on the Xena tester.



	Start Count

The starting number of addresses used in the test.



	End Count

The ending number of addresses used in the test.



	Step Count

The address count step increment.



	Only Use Max. Capacity

If checked the test will ignore the start, end and step options and only run the test at the max. capacity. This option is only used if an Address Caching Capacity test has previously been run as part of the same test and a capacity test result has been found for the frame size in question. Otherwise the test will default to use the start, end and step options.



	Set End = Max. Capacity

If checked the test will ignore the end count option value and use the max. capacity value instead. This option is only used if an Address Caching Capacity test has previously been run as part of the same test and a capacity test result has been found for the frame size in question. Otherwise the test will default to use the end option value.







Learning Rate Settings


	Base Learning Rate

The basic (i.e. maximum) learning rate used in frames/second. Note that the general port rate defined for the test configuration is ignored for this test.



	Initial Rate

The starting rate to use. This is specified as a percentage of the base learning rate.



	Maximum Rate

The maximum rate to use. This is specified as a percentage of the base learning rate and will typically be 100%.



	Minimum Rate

The minimum rate to use. This is specified as a percentage of the base learning rate. If the trial reaches this value the test is stopped and the result will be FAILed.



	Resolution Rate

The trial stops when the difference between the current and the last successful trial is less than the Resolution.







DUT Address Learning Reset


	Toggle Sync States

If checked the sync state of the test ports will be toggled off and on between test trials. Enabling this may help clearing the MAC learning tables in the DUT and speed up the test.



	Sync State Off Period

The amount of seconds the port sync states will be off.



	Delay After Sync On

Defines how long time Xena2889 will wait after the reset before it continues with the test.



	Switch Test Port Roles

If checked the port with the Test and Learning roles will be swapped between test trials. Enabling this may help clearing the MAC learning tables in the DUT and speed up the test.



	DUT Aging Time

If none of the two options above are checked the test will wait for the specified seconds between trials to ensure that the MAC table in the DUT has been cleared.







Port Role Configuration


	Used?

If checked the port will be used in this test.



	Port Role

Used to place the port in Test Port, Learning Port, or Monitoring Port.






Note

Only one test port, one learning port and one monitoring port are allowed in this test.
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Errored Frames Filtering Test Options
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Fig. 23 Errored Frames Filtering Test Options




Common Options


	Duration

The duration of each test trial in seconds.



	Iterations

The number of times to repeat each test trial with the same set of test parameters.







Rate Sweep Options


	Start Rate

The start rate to use in percent of the overall port rate defined.



	End Rate

The end rate to use in percent of the overall port rate defined.



	Step Rate

The step rate to use in percent of the overall port rate defined.







Test Frame Options


	Enable Oversize Test

If checked the oversize frames test will be performed. You can disable this if your DUT generally supports very large frame sizes and you don’t want to bother testing this.



	Max. Valid Frame Size

The maximum valid frame size you believe your DUT should support.



	Oversize Test Span

The number of oversize frame sizes to use in the test. The frame sizes used will be in the range [max. valid size + 1, max. valid size + span].



	Min. Valid Frame Size

The minimum valid frame size you believe your DUT should support. This value should typically be 64.



	Undersize Test Span

The number of undersize frame sizes to use in the test. The frame sizes used will be in the range [min. valid size-1, min. valid size-span].







Port Role Configuration


	Used?

If checked the port will be used in this test.



	Port Role

Used to place the port in either Source or Destination.






Note

Only one source and one destination are allowed in this test.
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Broadcast Forwarding Test Options
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Fig. 24 Broadcast Forwarding Test Options




Common Options


	Duration

The duration of each test trial in seconds.



	Iterations

The number of times to repeat each test trial with the same set of test parameters.







Throughput Test Options


	Initial Rate

The starting rate to use. This is specified as a percentage of the overall port rate defined in the general test options panel.



	Maximum Rate

The maximum rate to use. This is specified as a percentage of the overall port rate.



	Minimum Rate

The minimum rate to use. This is specified as a percentage of the overall port rate. If the iteration reaches this value the test is stopped and the result will be FAILed.



	Resolution Rate

The trial stops when the difference between the current and the last successful trial is less than the Resolution.







Port Role Configuration


	Used?

If checked the port will be used in this test.



	Port Role

Used to place the port in either Source or Destination.






Note

Only one source and one destination are allowed in this test.
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Protocol Segment Profile Panel

This panel allow you to configure the protocol segment profiles used by the test ports.You can either use a single common profile for all ports or use a separate profile for each port. In this way you can define an asymmetric traffic setup.


Available Profiles List

The list view at the top show all defined profiles.


[image: ../_images/protocol_seg_profile.png]

Fig. 25 Protocol segment profiles




Managing Profiles

You can create and delete profiles to match the need of the current test scenario. To create a new profile press the Add Profile button. To delete a profile select it in the list view and press the Remove Profile button.

You can however not delete a profile that is currently being used by a test port. You can see the number of test ports currently using a profile in the Use Count column in the list view at the top.To delete a profile that is in use you will first have to reassign all ports currently using that profile to another profile.



Default Profiles

When you create a new Xena2889 configuration it will be populated with a number of default profiles. You can however freely modify and even delete one or more of the default profiles.

If for some reason you want to restore the default profiles you can press the Restore Default Profiles button. This will unconditionally remove all current profiles (also those that are in use) and restore the default set. All test ports will be associated with the first default “Ethernet-only” profile.




Profile Editor

You can edit each profile by selecting it in the top list view and using the tree view control below.


Add and Remove Segment Headers

To add a new segment header press the Add button in the Segments section to the right. You will then be presented with a dialog listing all built-in segment types from which you can select one or more types to be included. If you want to use a segment not currently supported by the Xena2889 you can add a raw segment and specify the length in bytes. You can then afterwards edit the values in the resulting segment using the hex editor at the bottom.

You can remove one or more segments by selecting them and pressing the Remove button in the Segments section. You can change the order in which the segment headers appear by using the Move Up/Down buttons.

The Xena2889 will automatically adjust the value of any standard “”next-protocol” field (such as the EtherType field) in the segment headers when other segments are added, removed or moved.



Editing Field Values

The segment editor provides a tree view similar to the one found in the Wireshark protocol analyzer. You can thus expand each segment branch to view and optionally modify the various field values. Each field title is preceded with a small icon indicating the type of field value (decimal, hexadecimal, binary or IPv4/IPv6 address).

Certain fields, such as the EtherType, are associated with a set of commonly used named values. These can be selected in the Named Values column. You are however free to enter any value you want in the Raw Value column.

You can also edit the hex value of the segment headers directly using the hex editor at the bottom if you are so inclined.



MAC and IP Addresses

The address fields in the Ethernet and IP section headers will usually be overridden by the Xena2889 when the test streams are created:

The Source MAC (SMAC) address field in the first Ethernet segment will be set to the MAC address of the source port.

The Destination MAC (DMAC) address field in the first Ethernet segment will be set to the MAC address of the destination port. If an IP segment has been defined and a gateway IP address is defined for a source port, the Xena2889 will however attempt to resolve the MAC address of the gateway using ARP or NDP and wil then use this MAC address as the DMAC.

The IP Source/Destination Address fields in the IP segment header will be set to the values configured on the ports, as explained in the Selected Ports panel section above.

This replacement will however only be performed if you leave the fields at their default (all-zeros) value. If you specify anything else this value will be used instead.




Modifiers

It is possible to attach a modifier definition to one or more fields. A modifier will exercise the field with various values during the test and can be used to emulate a certain dynamic behavior. Modifiers are often used to exercise either the VLAN PCP or the IP DHCP fields. Alternatively one could apply modifiers to address fields like the DMAC field or the source or destination IP address fields.


Adding a Modifier

To add a modifier to a field simply select the field and press the Add Modifier button in the command panel to the right or right-click and select the Add Modifier popup menu option. A Create New Modifier dialog will now be shown. The content of the dialog will depend on the type of field. Most fields will use the Basic Modifier dialog shown below to the left. If the selected field is an IP address the IP Modifier dialog shown below to the right will be used instead.


[image: ../_images/basic_mod.png]

Fig. 26 Basic modifier
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Fig. 27 IP modifier



Fill in the various field values and press the OK button to add the modifier to the field. Once a modifier has been added to a field this will be indicated by a small blue M icon as shown in the screenshot above.



Editing a Modifier

To edit an existing modifier either select the field and press the Edit Modifier button in the command panel to the right, or right-click and select the Edit Modifier popup menu option. You will see the same dialog as was used to create the modifier.



Removing a Modifier

If you want to remove a modifier from a field simply select the field and press the Remove Modifier button in the command panel to the right, or right-click and select the Remove Modifier popup menu option.



Limitations

There is a limitation on the maximum number of modifiers that can be defined for each test stream. The limitation is specific for the test module type to which the port belong. Refer to the Xena Test Module Comparison Page for further details.




Value Ranges
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Fig. 28 Value Ranges



A Value Range is intended to exercise one or more fields in a Xena2889 protocol segment profiles with varying values. It is kind of similar to the hardware modifier explained above, with the following differences:


	A Modifier is handled by hardware and varies a field value between packets on the same stream.


	A Value Range is handled by software and varies a field value between different streams. All packets on the same stream have the same value.


	A Value Range is defined on a field in a protocol segment profile, just like a modifier. It will then be used for all streams created on a port which is assigned this profile.


	Value ranges can be used for both normal single-stream and advanced multi-stream scenarios. For normal scenarios it is most applicable for mesh configurations where multiple streams will be created on each port.




There is no limit to the number of values ranges added to a configuration. It is also possible to add both a modifier and a value range to a field. Whether that would yield usable results is unclear but it might be useful for larger fields.



PCAP Import

You can import the protocol segment structure from a PCAP file captured using Wireshark or any other capture application capable of generating a standard PCAP file. If the file contains multiple packets Xena2889 will display a list allowing you to select the desired packet.

Xena2889 will attempt to decode the packet and display the known protocol headers and their fields. Any unknown fields will be displayed as a raw segment. As there are limitations in the max.size of a custom segment the import may not be possible in some cases. The import dialog will inform you about this if the situation arises.
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Report Options Panel

The Reporting Options panel contains a number of options that affect the way reports are generated for the test.


Report Identification

This section contains a number of options that can help identify the test context.


	Customer Name

The name of the customer for which the test is performed.



	Customer Service/Access Id

These two options allow you to provide details about the network circuits you are testing.



	Comments

Allows you to provide any multi-line comments for the test configuration.







Report Generation Options

This section contains options that affect the way reports are generated.


Report Naming


	Report Filename Prefix

Specifies the prefix for the report filename.



	Append Timestamp to Filename

If checked a timestamp on the form <YYYYMMDD-HHMMSS> is appended to the filename prefix.







Report Content


	Packets/Frames Terminology

This property allows you to determine whether the units of data are referred to as packets or frames.



	Include Module Information in Report

If checked the report will also contain information for each module.



	Include Detailed Port Information in Report

If checked the report will also contain detailed results for each port. If unchecked only the totals will be reported.



	Include Stream Information in Report

If checked the per-stream information will also be included in the reports.



	Include Charts in Report

If checked the report will include bar charts showing the test results. This is only applicable for PDF type reports.



	Throughput Unit for Charts

Use this to select whether to use frames/second ot bits/second as the unit for throughput charts.








Report Formats

This section allows you to select which types of reports will be generated. You can enable several types. The generated report files will be given a file extension that matches the selected type, i.e. .pdf for PDF files and so forth.


XML Report Specification

You can find the specification for the XML Report here.

In the Report formats section you can also activate the Also Log Intermediate Results option. It will log intermediate results for each test type to separate CSV log files (one for each enabled test type) located in the Result Log subdirectory in the main Xena2889 Reports directory. If you check Add Timestamp For Each Line each line in the Intermediate Results file will include a timestamp. If you check Use Report Name Prefix the Report Name Prefix will also be used for naming of the intermediate result files.
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Result Data Panel

The Result Data panel will display both polled progress data and result data for the tests being executed in a grid view. Each result will be shown in a single line in the grid.

The polled progress data is updated periodically while the current test trial is executing and will be shown with an italics font. After the test trial has completed the result data for that trial will be calculated and shown with a normal font.


[image: ../_images/result_data_grid.png]

The Result State column will shown the state of the current trial run. While the test trial is in progress the state will always be (pending). A trial result may be final in which case the column will show either PASS or FAIL, depending on the test outcome. If the test needs to perform another iteration the state will again be (pending).

The columns used will depend of the test being performed. Most tests will provide a set of totals values and a set of per-port values but as stated this depends on the test.

Most cell values will be displayed using the normal font color. Values that indicate an error, such as a non-zero loss value, will be displayed with a red font color.
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Configuration Errors Panel

This panel will show any configuration errors detected by the program when you attempt to execute a configuration. If any such errors are found the panel will be shown and the execution attempt will be aborted. You will have to correct any reported errors before the program will allow you to execute the configuration.


[image: ../_images/config_errors.png]

Fig. 29 Configuration errors panel



Each error will be shown in a separate line in the panel. If you double-click on an error message you will be taken to the relevant configuration panel that will allow you to correct the error.

This panel is by default found in the lower auto-hiding panel group. By “auto-hiding” we mean that the panel is initially hidden but will popup either if the panel tab is clicked or if the application decides that it is necessary to direct the attention of the user to the panel. You can make the panel visible always by clicking the little “pin” icon in the top-right of the panel header.
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Application Settings

The xena2889 application features a number of application-level settings which are valid for all test configurations. These can be accessed in the Options menu item as shown in the figure below.


	Set Username

Allows you to specify the username used when logging in to the Xena testers. The default value will be your Windows username (shortened to 8 characters if longer).



	Ask to Relinquish Ports

If checked the xena2889 will prompt you when you try to use a port which is currently reserved by someone else. If unchecked the xena2889 will unceremoniously relinquish the port and reserve it in your name.



	Open Last Configuration On Start

If checked the configuration you had open when you last closed the application will automatically be opened the next time you start the application.



	Set Reports Path

Allows you to specify a different location for the generated reports. The default location is <ProgramData>/XenaNetworks/xena2889/Reports. The location of <ProgramData> varies between versions of Windows but can be obtained by inspecting the environment variable ProgramData.



	Set Tester Company Name

Allows you to set the name of the company performing the tests. The default value is “Xena Networks”.



	Set Tester Company Logo File

Allows you to specify the path to an image file which will be used as the logo in the reports. The default logo is the Xena Networks logo. The image can be in PNG or JPG format. It should have the approximate dimensions of 150 x 60 pixels and be set to a DPI of 96.



	Open Report in Associated Viewer

If checked the xena2889 will attempt to open the generated report in the associated viewer. This is currently only applicable for PDF reports. This requires that a suitable PDF viewer (such as the Adobe Acrobat Reader) is installed on your PC.
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Troubleshooting

This section contains some guidelines when you encounter a problem with Xena2544, Xena2889, Xena3918, Xena1564, and XenaManager and want to obtain help from your support representative.


Basic Instructions

This section explains how you should report a problem to your support representative.


Describe the Problem

To enable fast resolution of your problem we request that your support request contains the following information:


	Name and version of the Xena test software used (the version can be seen in the main title bar)


	A description of what you are trying to do with the software.


	If the software misbehaved please describe what you actually encountered and you expected instead.


	Screenshots of any error situation.


	The test configuration file for the application (contained in the support archive).


	Any debug log files for the application (contained in the support archive).






Create a Support Information Archive


[image: ../_images/help.png]

The Xena test applications include a menu entry called Create Support Information Archive which will create a compressed ZIP archive containing both the currently loaded configuration file and the content of the Logs and Settings directories. This file can then be emailed to your support representative.

For the Xena2544 and similar test applications this menu entry is located in the Help menu. For the XenaManager application it is located in the Tools ribbon menu.


Note

For the Xena2544 and similar test applications it is important that the configuration file used when the problem was detected is loaded when the support archive is generated. Otherwise the configuration file will not be part of the archive.





Attach Screenshots

Screenshots are a great and easy way of communicating what you see on the screen. To obtain a screenshot of a running program and send it to Xena support perform the following actions:


	Point your mouse inside the program window.


	Press the Alt-PrintSc keys simultaneously.


	Switch to your email program and start a new email message.


	Press Ctrl-V or select Paste from the menu (most likely the Edit menu) to insert the screenshot into the email.







Additional Details

This section goes into a bit more detail about the various items contained in the Xena Support Archive mentioned above.


Configuration Files

The Xena test applications keeps their configurations in special files with an application-specific extension. The extensions used are as follows:


	Xena2544:      .x2544


	Xena2889:      .x1564


	Xena3918:      .x3918


	Xena1564:      .x1564


	XenaManager: .xmcfg




The configuration files will be located in a common Xena data directory on your PC. More specifically they will be located in the following path: C:<UserAppDataDir>Xena<XenaTestApplication>. The <UserAppDataDir> directory depends on your Windows version.

The Xena test applications include a menu entry called Explore Xena Data Directory in the File menu that will open a Windows Explorer in the correct directory, regardless of the Windows version.



Debug Log Files

The Xena test applications logs certain events and errors to a series of debug log file located in the Logs subdirectory under the above mentioned main application data directory. If you encounter errors it may help the support if you include these files in your support request.
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Glossary of Terms


	Blocks Typology
	A topology where each port is associated with either the EAST or the WEST group. Each port in the EAST group will then communicate with all ports in the WEST group, and vice versa. There are thus no direct relation between ports like there are for the Pairs topology. The transmit and receive roles of the ports are determined by the Direction setting.



	Direction
	Denotes the direction of the traffic flows in relation to the group definitions. The direction can be either unidirectional or bidirectional. Unidirectional flows can be either EAST-to-WEST or WEST-to-EAST.



	DUT
	Device Under Test



	FDV
	Frame Delay Variance



	FTD
	Frame Transfer Delay



	IGMP
	Internet Group Management Protocol



	IGMPV2
	Internet Group Management Protocol v2



	IGMPV3
	Internet Group Management Protocol v3



	Iteration
	Each test-type can be configured to repeat the test runs associated with the test-type a number of times. Each of these additional runs is called an iteration.



	Mesh Typology
	A topology where all ports communicate with each other. The direction will always be bidirectional and the EAST/WEST group attribute is not used.



	MPLS
	Multiprotocol Label Switching (MPLS) is a routing technique in telecommunications networks that directs data from one node to the next based on labels rather than network addresses.



	Pair Typology
	A topology where each port is associated with exactly one other peer port. The ports must be associated with opposing EAST/WEST groups. A test configuration can contain several port pairs. The transmit and receive roles of the two ports are determined by the Direction setting.



	Run
	Run     A “test run” (or simply “run”) denotes the part of the test configuration that is associated with a single test-type and a single packet size. This concept is used for the purpose of progress reporting. A test configuration that specifies the use of e.g. 5 packet sizes and has enabled 3 of the possible 4 test-types will thus consist of 5*3 = 15 runs.



	Test Type
	Denotes one of the the four types of tests according to RFC 2544[#1]: Throughput, Latency (and Jitter), Loss, and Back-to-Back (a.k.a. Burst).



	TG
	Traffic Generation



	TID
	Test payload identifier



	TPLD
	Test payload



	Trial
	A “trial” denotes a single execution of an iteration.



	VLAN
	Virtual local area network (VLAN) is any broadcast domain that is partitioned and isolated in a computer network at the data link layer (OSI layer 2).






Footnotes



[#1]
https://datatracker.ietf.org/doc/html/rfc2544.html
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Address Learning Rate (EFC 2889 section 5.8)

Errored Frames Filtering (EFC 2825 =ection 5.9, se below for details)
Broadcast Forwarding and Latency (EFC 2829 =ection 5.10)

Configuring Tests
To inspect and optionally change the test options for each test, select the test in the treeview.

Port Roles
For each test it is possible to assign roles to the ports selected for the test. Not all selected ports may be used in every test.

Controlling Test Execution State
The checkbox to the left of the test name in the treeview determines whether the test is executed or not.

Handling Rate Tests
The RFC 2889 defines several types of rate tests, but these are typically not possible to execute using the same test setup. Instead the Vallkyrie2889 allow you to create and define the
number of rate tests relevant for the actual DUT.

To create a new rate test press the Add button located at the bottom of the test treeview. You can configure both the topology and the direction for the rate test, and also set the port roles for
the test.

To delete a rate test select the test and press the Remowe button located at the bottom of the test treeview.

Mapping of RFC 2889 rate tests to topology settings:

Fully meshed: Topology: Mesh, Direction: Bidirectional

One-to-many: Topology: Elocks, Direction: East-to-West. Place one port in the East group, and all other ports in the West group.

Many-to-one: Topology: Blocks, Direction: West-to-East, otherwise as for the One-to-many test.

Partially meshed multiple devices: Topology: Blocks, Direction: Bidirectional.

Partially meshed unidirectional traffic: Topology: Blocks, Direction: East-to-West. Place first half of the test ports in the East group and the other half in the West group.

Errored Frames Filtering

The following tests are current not implemented by the Valkyrie2889:
+ Dribble Bit Errors
« Alignment Errors

| @ Test not running | Test Time: 00:00:00 | Duration: 00:00:00 | User: demo
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Further Assistance

Valkyrie2889

Valkyrie2889 Quick Start Guide
This short guide will help you get started using Valkyrie2888.

Add a Xena chassis to the current test configuration.
Select at least two ports in the Fhysical Ports panel at the left and drag them to the Selected Ports panel. In the Selected Ports panel you can then configure the individual properties of

The General Test Configuration panel contains options that affect all tests.

The Test Types Configuration panel allow you to select and configure the exact set of tests you want to perform.
Use the Protocol Segment Profiles panel to configure the protocol header profiles to use for the selected ports.
Review the reporting parameters in the Eeporting panel and adjust these as needed.

Press the Start button in the toolbar to start the selected tests.

For further assistance please refer to the online Xena help page which you can access by either selecting the Help -> Online Help menu item or by pressing F1

| @ Test not running | Test Time: 00:00:00 | Duration: 00:00:00 | User: demo
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Valkyrie2889 Quick Start Guide
This short guide will help you get started using Valkyrie2888.

Add a Xena chassis to the current test configuration.

The General Test Configuration panel contains options that affect all tests.

The Test Types Configuration panel allow you to select and configure the exact set of tests you want to perform.
Use the Protocol Segment Profiles panel to configure the protocol header profiles to use for the selected ports.
Review the reporting parameters in the Eeporting panel and adjust these as needed.

Press the Start button in the toolbar to start the selected tests.

e

Further Assistance

Valkyrie2889

Select at least two ports in the Physical Ports panel at the left and drag them to the Selected Ports panel. In the Selected Ports panel you can then configure the individual properties of the ports.

For further assistance please refer to the online Xena help page which you can access by either selecting the Help -> Online Help menu item or by pressing F1

| @ Test not running | Test Time: 00:00:00 | Duration: 00:00:00 | User: demo
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Valkyrie2889 Quick Start Guide
This short guide will help you get started using Valkyrie2888.

Add a Xena chassis to the current test configuration.

e

Further Assistance

Valkyrie2889

Select at least two ports in the Physical Ports panel at the left and drag them to the Selected Ports panel. In the Selected Ports panel you can then configure the individual properties of the ports.
The General Test Configuration panel contains options that affect all tests.

The Test Types Configuration panel allow you to select and configure the exact set of tests you want to perform.

Use the Protocol Segment Profiles panel to configure the protocol header profiles to use for the selected ports.

Review the reporting parameters in the Eeporting panel and adjust these as needed.

Press the Start button in the toolbar to start the selected tests.

For further assistance please refer to the online Xena help page which you can access by either selecting the Help -> Online Help menu item or by pressing F1

| @ Test not running | Test Time: 00:00:00 | Duration: 00:00:00 | User: demo
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